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Audacity	subir	volumen

	Para	aumentar	el	volumen	en	Audacity	sin	perder	calidad,	utiliza	el	efecto	Normalizar.	Abre	Audacity	y	carga	el	archivo	de	audio;	selecciona	la	pista	y	ve	a	"Efecto"	>	"Volumen	y	compresión"	>"Normalizar..."	para	abrir	el	cuadro;	luego,	ajusta	los	valores,	previsualiza	la	canción	y	descárgala.	Subir	el	volumen	del	audio	es	esencial	para	garantizar	una
audibilidad	clara,	sobre	todo	en	situaciones	como	presentaciones	o	al	escuchar	podcasts	o	canciones	antiguas	que	contienen	secciones	de	bajo	volumen	casi	inaudibles.	Ajustar	constantemente	el	volumen	del	reproductor	de	audio	puede	ser	muy	irritante	y	puede	llevar	a	niveles	de	volumen	extremos	que	pueden	dañar	la	audición.	Por	suerte,	existen
soluciones	a	este	problema	en	Audacity,	un	software	de	edición	de	audio	de	código	abierto	y	aumentadores	de	volumen	MP3	disponible	gratuitamente.	En	el	artículo	se	enumeran	cuatro	métodos	diferentes	para	dar	una	pista	sobre	cómo	aumentar	el	volumen	de	audio	en	Audacity	sin	distorsión.	1.	Amplifica	el	sonido	en	Audacity	En	Audacity,	el	efecto
Amplificar	aumenta	el	volumen	del	audio	manteniendo	los	niveles	relativos	de	las	pistas.	Ajusta	cada	pista	uniformemente	en	función	de	la	más	alta,	asegurando	la	claridad	sin	alterar	el	equilibrio	entre	pistas.	Sin	embargo,	puede	distorsionar	si	el	volumen	inicial	de	amplificación	es	demasiado	alto.	Paso	1.	Inicia	Audacity	e	importa	tu	archivo	de	audio.
Ve	a	"Archivo"	>"Importar"	>"Audio"	para	elegir	el	archivo	local.	Audacity	admite	WAV,	AIFF,	MP3,	OGG,	FLAC	y	MP2.	Pero	si	se	trata	de	un	archivo	de	codificación	de	audio	avanzada	como	M4A,	necesitarás	instalar	una	biblioteca	FFmpeg.	Paso	2.	Selecciona	la	pista	de	destino.	Selecciona	una	parte	de	la	pista	de	audio	o	haz	clic	con	el	botón
izquierdo	del	ratón	dos	veces	para	seleccionar	toda	la	canción.	O	sube	a	"Seleccionar"	>"Todo".	Paso	3.	Utiliza	el	efecto	Amplificar.	Ve	a	"Efecto"	>"Volumen	y	compresión"	>"Amplificar..."	para	abrir	la	ventana	Amplificar.	Aquí	verás	Amplificación:	Introduce	un	valor	para	amplificar	el	sonido.	Los	valores	positivos	aumentan	el	volumen,	mientras	que
los	negativos	lo	disminuyen.	Empieza	con	un	valor	pequeño.	Nueva	Amplitud	de	Pico:	El	nivel	de	audio	más	alto	después	de	aplicar	los	cambios,	lo	que	ayuda	a	evitar	la	distorsión.	Permitir	recorte:	Cuando	no	está	marcada,	al	introducir	un	valor	de	amplificación	que	cause	una	Nueva	Amplitud	de	Pico	superior	a	0	dB	se	desactiva	el	botón	Aceptar,
evitando	una	amplificación	excesiva.	Cuando	está	marcada	(por	defecto),	puedes	amplificar	libremente,	con	riesgo	de	distorsión.	Paso	4.	Previsualiza	y	descarga.	Pulsa	"Vista	previa"	para	escucharlo,	y	pulsa	"Aplicar"	para	iniciar	el	proceso.	Expórtalo	desde	"Archivo"	>"Exportar"	>"Exportar	como...".	2.	Normaliza	el	audio	para	hacerlo	más	alto	en
Audacity	El	efecto	Normalizar	de	Audacity	sirve	para	ajustar	las	amplitudes	de	pico	de	las	pistas	o	selecciones,	garantizando	la	coherencia	entre	varias	pistas	y	equilibrando	los	canales	estéreo.	También	elimina	cualquier	desplazamiento	de	CC	presente	en	las	pistas.	A	diferencia	de	la	normalización	independiente,	que	maximiza	el	volumen	por	pista	o
canal,	Normalizar	armoniza	las	amplitudes	de	pico	y	el	equilibrio	de	canales	entre	selecciones	y	pistas.	Paso	1.	Abre	Audacity	y	carga	tus	grabaciones.	Para	quienes	ya	hayan	guardado	su	archivo	de	audio	como	proyecto	en	Audacity,	prueba	con	"Archivo"	>"Abrir..."	o	"Archivo"	>"Archivos	recientes"	para	abrirlo.	Paso	2.	Elige	la	pista	de	audio	y	aplica
el	efecto	Normalizar.	Ve	a	"Efecto"	>	"Volumen	y	compresión"	>	"Normalizar..."	para	abrir	el	cuadro.	Elimina	el	desplazamiento	de	CC:	Centra	la	forma	de	onda	en	el	nivel	de	amplitud	0,0	para	evitar	chasquidos	y	distorsiones	y	maximizar	el	espacio	libre	disponible	para	la	normalización.	Normalizar	Amplitud	Máxima	a:	Establece	el	nivel	máximo	para
la	selección	procesada.	El	valor	por	defecto	es	-1	dB,	lo	que	proporciona	margen	para	efectos	y	reproducción	sin	distorsión.	La	introducción	de	valores	positivos	está	desactivada.	Normaliza	los	canales	estéreo	independientemente:	Sin	marcar	(por	defecto),	Normalizar	conserva	el	equilibrio	de	la	pista	estéreo.	Marcada,	ajusta	los	canales	izquierdo	y
derecho	por	separado,	lo	que	resulta	adecuado	para	corregir	grabaciones	estéreo	desequilibradas	tras	eliminar	los	clics.	Paso	2.	Previsualiza	y	descarga.	Haz	clic	en	"Vista	previa"	para	reproducir	la	canción,	y	haz	clic	en	"Aplicar"	si	te	gusta	el	resultado.	Exporta	el	archivo	de	audio	según	necesites.	3.	Utiliza	Envelope	Tool	para	subir	el	volumen	en
Audacity	Envelope	Tool	ajusta	suavemente	los	cambios	de	volumen	mediante	puntos	de	control	situados	en	la	pista.	Cada	punto,	con	cuatro	asas,	te	permite	modificar	los	niveles	de	volumen.	Las	asas	de	arrastre	evitan	la	distorsión	más	allá	de	la	envolvente	de	volumen	original,	mientras	que	las	asas	interiores	amplifican	el	audio	en	silencio	más	allá
de	la	envolvente	de	la	pista.	Paso	1.	Inicia	Audacity	y	abre	la	pista	de	audio.	Si	ya	tienes	un	proyecto	en	Audacity,	prueba	con	"Archivo"	>	"Archivos	recientes"	para	abrirlo.	Paso	2.	Elige	todo	el	audio	o	parte	de	él.	Paso	3.	Haz	clic	en	Envelope	Tool	de	la	barra	de	herramientas.	Desplaza	el	ratón	y	pulsa	el	botón	Ctrl	para	ampliar	el	trazado,	y	luego
pulsa	el	botón	del	ratón	sobre	un	trazado	para	añadir	un	nuevo	punto	de	control.	Para	eliminarlo,	arrástralo	fuera	de	la	pista.	El	sonido	hará	una	transición	suave	entre	cada	punto	que	establezcas,	así	que	añade	sólo	lo	que	necesites.	Haz	clic	en	la	parte	superior	o	inferior	de	una	pista	para	añadir	un	nuevo	punto.	Si	tu	pista	es	estéreo,	ambos	canales
seguirán	los	mismos	cambios.	Paso	4.	Edita	los	puntos	de	control.	Haz	clic	en	el	punto	de	control	y	arrástralo	mientras	pulsas	el	botón	izquierdo	del	ratón.	Arrastrar	un	punto	de	control	más	allá	de	otro	está	desactivado.	Puedes	utilizarlo	para	especificar	cambios	en	el	volumen	y	activar	un	deslizador	de	ganancia	para	ajustar	el	volumen	sin	alterar	la
forma	de	onda.	Paso	5.	Escucha	y	exporta.	Cuando	estés	satisfecho	con	el	trabajo	final,	exporta	el	formato	que	desees.	Aquí	tienes	un	vídeo	que	resume	todo	el	proceso:	0:00	¿Cómo	hacer	que	tu	audio	suene	más	fuerte?	0:31	Utiliza	esta	herramienta	en	Audacity	0:50	Antes	y	Después	del	audio	0:55	Otra	forma	de	subir	el	Audio	1:20	Tercera	forma	de
aumentar	el	volumen	de	tu	audio	4.	Aplicar	el	compresor	para	aumentar	el	volumen	de	una	sección	en	Audacity	En	situaciones	como	las	grabaciones	de	presentaciones,	en	las	que	el	micro	del	presentador	capta	las	preguntas	del	público	a	un	volumen	más	bajo,	puede	que	sólo	quieras	ajustar	partes	concretas	del	volumen	del	audio.	Aquí	es	donde	el
compresor	incorporado	resulta	valioso.	Reduce	el	rango	dinámico	del	audio	sin	provocar	recortes,	gestionando	eficazmente	los	distintos	niveles	de	volumen	de	la	grabación.	Paso	1.	Sube	tu	archivo	de	audio	a	Audacity	y	selecciona	la	parte	de	destino.	Para	los	archivos	sin	cabeceras	estándar	como	RAW	o	VOX	ADPCM	o	los	que	tienen	cabeceras	no
estándar,	utiliza	"Archivo"	>"Importar"	>"Datos	sin	procesar"	para	importarlos	en	Audacity.	Paso	2.	Utiliza	el	Compresor.	Accede	a	"Efecto"	>	"Volumen	y	compresión"	>	"Compresor..."	y	verás	el	gráfico.	Umbral:	Valor	del	nivel	de	compresión.	Suelo	de	ruido:	Controla	la	ganancia	de	audio	por	debajo	de	los	niveles	de	fondo	para	evitar	la	sobre-
amplificación.	Relación:	Reduce	el	audio	más	allá	de	un	umbral.	Los	Ratios	más	altos	comprimen	más	las	partes	más	altas.	Tiempo	de	ataque:	Decide	lo	rápido	que	reacciona	cuando	el	volumen	supera	el	umbral.	Los	tiempos	de	ataque	cortos	reaccionan	a	los	sonidos	fuertes.	Tiempo	de	liberación:	Decide	lo	rápido	que	recupera	el	volumen	tras	caer	por
debajo	del	umbral.	Los	tiempos	de	liberación	largos	sacrifican	los	sonidos	más	suaves	después	de	los	fuertes.	Ganancia	de	compensación	para	0	dB	después	de	comprimir:	Tras	la	compresión,	todas	las	pistas	seleccionadas	se	amplifican	para	alcanzar	un	nivel	de	pico	de	0	dB,	utilizando	la	misma	amplificación	que	el	efecto	Amplificar.	Comprimir	en
base	a	Picos:	Ajusta	el	umbral	y	la	ganancia	basándote	en	los	valores	pico	de	la	forma	de	onda	para	una	compresión	"ascendente",	amplificando	menos	los	sonidos	más	altos	que	los	más	bajos,	en	contraste	con	la	compresión	"descendente"	de	RMS,	que	reduce	los	sonidos	más	altos	dejando	inalterados	los	más	bajos,	sin	amplificación	en	el	nivel	original
de	0	dB.	Paso	3.	Exportar.	Aplica	las	opciones	y	previsualiza.	Selecciona	la	carpeta	para	almacenar	el	audio,	y	elige	la	frecuencia	de	muestreo,	las	opciones	de	audio	y	el	rango	de	exportación.	¡Comparte	el	tutorial	con	otras	personas	que	necesiten	aumentar	el	volumen	en	Audacity	sin	recortar!	Aumenta	el	Volumen	de	Audio	Online	Gratis	con
Cambiador	de	Voz	de	EaseUS	Online	Si	prefieres	una	forma	de	automatizar	tu	flujo	de	trabajo,	Cambiador	de	Voz	de	EaseUS	Online	es	el	camino	a	seguir.	Es	un	elevador	de	volumen	de	audio	gratuito	que	soporta	múltiples	formatos	de	archivo	como	MP3,	WAV,	M4A,	FLAC	y	más,	y	permite	cambiar	el	volumen	de	0	a	3x.	Tiene	una	interfaz	intuitiva	con
un	flujo	de	trabajo	sencillo.	Además,	este	mejor	eliminador	de	voces	también	sirve	como	cambiador	de	tono,	cambiador	de	velocidad	y	extractor	de	acapellas.	El	límite	máximo	de	tamaño	de	archivo	es	de	150	MB	para	grabaciones	de	hasta	20	minutos,	lo	que	permite	a	los	usuarios	ajustar	el	volumen	del	audio	según	sus	necesidades.	Características
principales	Eliminar	ruidos,	instrumentos	y	voces	de	las	canciones.	Bajar	y	subir	el	volumen.	Acelerar	el	MP3	a	1,5x.	Encontrar	la	tonalidad	de	una	canción.	Cambia	el	tono	de	tus	canciones.	Accede	ahora:	Eliminador	de	Voz	Online	de	EaseUS	Con	IA	avanzada	Sigue	los	pasos	para	amplificar	el	sonido	en	línea:	Paso	1.	Ve	al	sitio	web	y	busca
el	"Cambiador	de	tono".	Paso	2.	Busca	en	la	biblioteca	local	o	arrastra	y	suelta	tu	archivo	sin	límite	en	la	zona.	Paso	3.	Mueve	el	deslizador	de	volumen	a	izquierda	o	derecha	para	ajustar	el	volumen	de	0	a	3x.	Selecciona	"Reemplazar	el	archivo"	para	modificarlo.	Tras	el	ajuste,	pulsa	"Guardar	y	exportar"	para	descargar	el	archivo	con	el	volumen
alterado.	Para	terminar	En	conclusión,	estos	cuatro	métodos	ofrecen	formas	eficientes	de	subir	el	volumen	en	Audacity	sin	distorsión,	atendiendo	a	diversas	preferencias	de	usuario	y	requisitos	técnicos.	Sin	embargo,	para	los	que	buscan	una	solución	fácil	de	usar	y	eficaz,	Cambiador	de	Voz	de	EaseUS	Online	destaca	como	el	mejor	amplificador	de
volumen	de	audio	gratuito,	ya	que	proporciona	una	experiencia	perfecta	para	mejorar	los	niveles	de	audio	manteniendo	la	claridad	y	la	calidad.	Eliminador	de	Voz	Online	de	EaseUS	Con	IA	avanzada	Preguntas	Frecuentes	sobre	subir	el	volumen	en	Audacity	1.	¿Cómo	aumentar	el	volumen	del	audio	sin	perder	calidad?	Para	subir	rápidamente	el
volumen	sin	alterar	la	dinámica:	Utiliza	la	normalización	para	subir	el	volumen	de	todo	el	archivo	de	audio	de	modo	que	el	pico	de	volumen	más	alto	esté	justo	por	debajo	de	0	dBFS.	Este	proceso	no	añade	distorsión	ni	recortes.	Para	los	productores	que	buscan	un	sonido	más	fuerte	en	la	"guerra	de	la	sonoridad":	Considera	la	posibilidad	de	utilizar
compresión	multibanda,	como	el	finalizador	t.c.electronic,	para	aumentar	el	volumen	medio	del	audio	sin	elevar	necesariamente	el	volumen	de	los	picos	más	altos.	Este	método	puede	hacer	que	el	audio	suene	más	alto	para	la	percepción	humana.	2.	¿Cómo	aumento	el	volumen	en	Audacity	sin	recortar?	Para	aumentar	el	volumen	en	Audacity	sin
recortar:	Carga	un	archivo	de	audio	en	tu	Audacity.	Selecciona	la	pista	y	desplázate	hasta	"Efecto".	Elige	"Normalizar..."	y	ajusta	la	amplitud	del	pico	a	0	dB.	Pulsa	"OK"	y	escucha	tu	grabación.	3.	¿Por	qué	el	volumen	de	mi	Audacity	es	tan	bajo?	El	volumen	de	tu	Audacity	es	bajo:	Niveles	de	entrada	bajos.	Ajustes	inadecuados	del	micrófono	o	del
dispositivo	de	grabación.	Se	aplican	efectos	o	filtros	para	reducir	el	volumen.	Los	niveles	de	volumen	de	las	pistas	individuales	están	demasiado	bajos.	La	configuración	del	volumen	de	reproducción	está	mal	ajustada.	La	frecuencia	de	muestreo	del	audio	no	coincide	con	la	del	proyecto	en	Audacity.	Ajustes	de	monitor	para	altavoces/auriculares.	Share
—	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	—	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution	—	You	must	give	appropriate	credit	,	provide	a	link	to	the
license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	—	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	—	You	may	not	apply
legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the	permissions
necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	So	the	input	did	not	go	so	well	Can	I	increase	the	volume?	please	see	link	ImgBB	Image	Screenshot-2024-01-26-22-08-30	hosted	in	ImgBB	Select	just	the	bottom	waveform	and	Effect	→	Volume	and	Compression	→
Amplify.	Audacity	has	already	pre-scanned	your	file	and	Amplify	will	default	to	whatever	gain	is	needed	for	“maximized”	0dB	peaks.	Digital	amplification	doesn’t	hurt	anything	so	if	the	sound	quality	is	good,	it	will	be	good	and	just	louder.	The	top	waveform	appears	to	be	somewhat	clipped	(distorted)	but	it	MIGHT	just	go	over	0dB	(100%)	without
clipping,	which	Audacity	can	do	internally/temporarily.	If	it	does	go	over	0dB,	Amplify	will	default	to	an	attenuation	(a	negative	amplification	value)	and	bring	it	down	to	a	safe	label.	I	found	out	how	to	do	it	thanks!	So	IK	a	mplifed	it	a	little	but	problem	now	is	the	chorus	is	to	loud	and	the	verses	to	quite	Any	ideas	on	what	to	do	hear	please?	Thanks
ImgBB	Image	Screenshot-2024-01-29-01-37-16	hosted	in	ImgBB	P.S.	is	there	a	way	i	can	upload	.aup3	files	hear?	Taffy:	now	is	the	chorus	is	to	loud	Audacity’s	envelope	tool	can	be	used	to	reduce	the	volume	of	sections	of	audio.	Taffy:	P.S.	is	there	a	way	i	can	upload	.aup3	files	hear?	Allegedly	this	is	possible	via	Audacity’s	recent	“Share	audio”	feature.
Have	not	tried	the	last	link	yet;	but	in	the	first	it	says	Envelope	Tool	When	you	select	Envelope	Tool	from	the	Tools	Toolbar,	your	track,	which	normally	looks	like	this:	I	can	not	find	the	Envelope	from	the	tool	bar	i	can	post	a	screen	shot	any	more	so	there	is	not	much	ells	i	can	do!	An	error	occurred:	Sorry	you	cannot	post	a	link	to	that	host.	Taffy:	I	can
not	find	the	Envelope	from	the	tool	bar	Taffy:	So	IK	a	mplifed	it	a	little	but	problem	now	is	the	chorus	is	to	loud	and	the	verses	to	quite	Those	are	separate	tracks,	right?	There	is	a	+/-	volume	slider	to	the	left	of	each	track/waveform.	It	doesn’t	affect	what	you	see	but	it	affects	what	you	hear	and	it	affects	the	exported	mix.	Or,	the	Amplify	effect	can	be
used	for	amplification	(with	a	positive	value)	or	to	attenuate	(by	entering	a	negative	amplification	value).	Mixing	is	done	by	summation	so	you	usually	have	to	lower	the	level	of	one	or	both	tracks	to	prevent	clipping	in	the	mix.	(Audacity	won’t	clip	internally	but	your	exported	file	can	clip,	or	you	might	hear	clipping	when	you	play	it	because	your	DAC
can’t	go	over	0dB.)	If	you	only	have	two	tracks,	lowering	the	peaks	to	-6dB	(50%)	or	less	will	keep	the	mix	level	safe.	Or,	you	can	Mix	and	Render,	and	then	run	the	Amplify	or	Normalize	effect	to	bring	down	the	levels	before	exporting.	Or,	you	can	export	as	floating-point	WAV,	which	won’t	clip	but	you	shouldn’t	leave	it	that	way.	You	can	re-import	the
mix	and	Amplify	or	Normalize	before	exporting	to	your	desired	final	format.	Also,	if	these	are	“original”	recordings	(from	a	microphone)	they	are	uncompressed	and	even	with	“maximized”	0dB	peaks	they	won’t	sound	as	loud	as	commercial	recordings	which	always	have	dynamic	compression.	If	you	can’t	get	it	loud	enough	(without	clipping)	try	the
Limiter	effect	(either	with	Make-up	Gain,	or	you	can	re-amplify	after	limiting).	Limiting	is	a	fast-kind	of	dynamic	compression.	There	are	fewer	settings	to	mess	with	(or	to	mess-up)	than	the	Compressor	effect	and	it’s	usually	better	for	“loudness”.	…Don’t	confuse	dynamic	compression	(an	effect)	with	file	compression	like	MP3	(which	makes	smaller
files).	They	are	different	things.	I	managed	to	find	the	effects	button	thanks!	But	I	cant	seam	to	get	the	tool	to	move	the	sound	up	and	down.	with	out	being	able	to	upload	a	screen	shot	hear	there	is	not	much	more	that	i	can	say	sorry	i	dont	understand	any	of	that!	There	is	no	share	audio	button	on	my	menu	pannel!	Again	without	being	able	to	share
screen	shots	though	website	links	there	is	very	little	more	i	can	say	or	do!	Taffy:	There	is	no	share	audio	button	on	my	menu	pannel!	The	share	button	was	added	in	version	3.2.	…	If	you	have	3.2	or	higher,	try	reset	toolbars	to	display	the	share	button.	You	can	just	create	a	free	account	at	audio	dot	com,	and	upload	audio	manually.	That’s	what	I	did
here	…	Audcaity's	Helmet	radio	plugin	demo	BAAA	Sound	Effects	by	Trebor	|	Listen	on	audio.com	I	do	not	know	what	version	it	is.	but	its	a	new	install	on	a	linux	penguin	terminal	running	on	a	chromebok.	I	have	tried	what	you	have	said	and	it	dose	not	work!	Since	as	the	forum	is	now	blocking	web	page	links	and	has	no	facility	to	upload	files	hear.
there	is	very	little	that	can	be	done	hear	This	topic	was	automatically	closed	after	30	days.	New	replies	are	no	longer	allowed.	You	can’t	perform	that	action	at	this	time.	Audacity	is	an	audio	editing	platform	with	over	100	million	downloads.	It’s	a	free	app	that’s	easy	to	use	and	great	for	your	next	audio	project.	We’ll	go	over	how	to	increase	volume	in
Audacity,	including	an	entire	audio	clip	and	a	section	of	audio.	You’ll	also	explore	the	difference	between	the	Amplify	and	Normalize	features.	Read	on	to	learn	everything	you	need	about	editing	audio	levels	with	Audacity.	Increase	the	Volume	of	an	Entire	Track	in	Audacity	There	are	multiple	ways	to	adjust	Audacity	volume,	so	you’ll	want	to	consider
each	of	these	to	determine	which	works	best	for	your	purposes.	To	start,	hover	your	cursor	over	the	music	waveform	to	increase	Audacity’s	overall	volume	quickly.	Select	the	portion	of	audio	you	wish	to	amplify	by	clicking	and	dragging,	which	should	be	the	entirety	of	the	audio	clip	in	this	instance.	Alternatively,	you	can	head	to	the	Edit	bar	on	the	top
left	of	your	screen	and	press	the	Select	button,	then	the	All	button.	Once	you	have	your	audio	highlighted,	you	are	ready	for	the	next	step.	From	there,	click	Effect	and	Amplify.	Now	you	can	adjust	the	sound	by	changing	the	amplification	numbers	until	the	waveform	expands	to	fill	closer	to	the	top	and	bottom	of	the	window.	You	can	also	use	the
Normalize	feature.	Hit	Normalize	under	the	Effect	bar	and	apply	the	method	to	your	entire	clip,	and	you	can	boost	your	sound	to	a	certain	level.	You	may	wonder	about	the	difference	between	normalize	and	amplify,	so	we’ll	go	over	that	next.	Difference	Between	Normalize	and	Amplify	Normalize	and	Amplify	are	both	helpful	tools	when	figuring	out
how	to	increase	volume	in	Audacity.	The	effects	of	Normalize	and	Amplify	are	similar	for	a	simple	mono	track.	However,	there	are	several	key	differences	between	the	two	features.	For	instance,	the	Normalize	effect	can	help	you	edit	two	audio	clips	to	have	the	same	volume	level.	In	contrast,	Amplify	only	raises	your	audio	by	a	certain	amount.	Amplify
Amplify	increases	the	audio	level	by	a	certain	amount.	The	Amplify	feature	lets	you	set	a	new	peak	amplitude	and	increase	your	volumes	in	an	interdependent	way.	It	is	distinct	from	the	Normalize	feature,	which	raises	all	audio	to	a	specified	level	in	a	rudimentary	fashion.	You	can	access	the	Amplify	effect	feature	by	selecting	your	preferred	audio	clip
with	the	click	and	drag	tools.	Then,	press	Effect	>	Amplify.	An	Amplification	task	box	will	appear.	Set	your	new	Amplification	dB	level,	and	the	New	Peak	Amplitude	will	adjust	accordingly.	You’ll	be	well	on	your	way	to	increasing	your	audio.	Normalize	The	Normalize	tool	allows	you	to	set	the	volume	of	multiple	tracks	and	remove	any	DC	offset	from
your	tracks.	Hit	Effects	>	Normalize	to	access	the	Normalize	menu.	A	task	box	will	appear	and	let	you	set	a	peak	level	of	the	audio	clip	up	to	0	dB.	You	can	select	the	same	peak	level	for	two	tracks	to	have	the	same	volume.	Increase	the	Volume	of	a	Specific	Part	of	a	Track	in	Audacity	Sometimes	you	don’t	need	to	raise	the	volume	of	an	entire	audio
clip.	To	increase	the	sound	of	a	specific	piece	of	audio,	you’ll	need	to	split	the	audio	into	a	smaller	soundbite.	Then,	you	can	change	the	sound	level	of	each	clip.	We’ll	walk	you	through	a	step-by-step	process	and	teach	you	how	to	raise	the	volume	of	a	specific	audio	clip.	Split	Audio	in	Audacity	Go	to	the	selection	tool	in	Audacity.	Click	Edit,	then	Clip
Boundaries,	allowing	you	to	specify	a	single	audio	clip	for	editing.	A	pop-up	menu	will	appear	at	this	stage.	Click	on	the	Split	button	on	the	pop-up	menu,	and	your	selected	audio	will	separate	from	the	rest	of	the	clip.	You	can	also	use	several	helpful	keyboard	shortcuts	to	split	audio	easily.	You	can	hit	Control	+	I	on	a	PC	or	Command	+	I	on	a	Mac
device.	Increase	the	Volume	of	a	Specific	Part	of	a	Track	You	now	have	a	new	clip	of	audio	at	this	point.	Its	volume	can	be	increased	or	decreased	by	using	the	techniques	above.	You	can	select	the	entire	clip	with	Edit	>	Select	>	All.	From	there,	you	can	choose	either	the	Amplify	or	Normalize	options.	Remove	Silence	in	Audacity	Do	you	need	to
remove	silence	from	an	audio	clip?	Some	audio	has	sections	of	unwanted	silence,	but	don’t	worry.	There’s	an	easy	way	to	get	rid	of	the	silence	on	Audacity.	Audacity	doesn’t	have	a	feature	for	deleting	silence	from	an	audio	clip.	However,	you	can	combat	this	issue	by	reducing	the	audio	clip	to	zero	seconds,	effectively	deleting	it.	Use	the	Truncate
Silence	effect	to	reduce	quiet	sections.	Hover	your	mouse	over	the	Effect	bar	and	head	to	the	Truncate	Silence	option.	Next,	reduce	the	time	‘Truncate	to’	time	to	zero.	Audacity	automatically	detects	areas	of	silence,	so	you	don’t	have	to	select	specific	sections.	You	can	also	create	a	Crossfade	effect	to	shorten	the	time	between	audio	sections.	Click
and	drag	two	tracks	and	overlap	the	bits	of	audio.	You	will	delete	any	area	of	silence	between	the	clips	and	overlap	the	two	sections	of	audio.	How	To	Fade	Volume	Go	to	the	Effects	menu	on	your	Audacity	web	page	and	locate	the	Fade	In	and	Fade	Out	buttons.	These	allow	you	to	raise	and	lower	volume	quickly.	You	can	use	different	fade	lengths	for	a
minimal	or	maximal	effect.	To	Fade	In	or	Fade	Out,	select	the	length	of	an	audio	track.	Use	your	cursor	to	click	and	drag,	highlighting	the	area	of	audio	you	wish	to	edit.	Next,	hit	the	Effects	menu	and	Fade	In	to	increase	the	audio	of	the	select	portion.	Once	you’ve	hit	that,	you	will	see	your	audio	track	lower	in	volume	(if	you	used	the	‘Fade	In’	effect).
Alternatively,	you	can	press	Effects	>	Fade	Out	to	gradually	decrease	the	clip’s	volume,	creating	a	tapering	effect.	Conclusion	Knowing	how	to	increase	volume	in	Audacity	will	become	second	nature	by	following	these	quick	and	easy	tips.	You	can	utilize	several	Audacity	features	to	find	the	perfect	volume	adjustment	for	your	audio	track.	,	the	free
encyclopedia	that	anyone	can	edit.	119,323	active	editors	6,997,882	articles	in	English	"Chinese	character"	written	in	traditional	(left)	and	simplified	(right)	forms	Chinese	characters	are	logographs	used	to	write	the	Chinese	languages	and	others	from	regions	influenced	by	Chinese	culture.	The	function,	style,	and	means	of	writing	characters	have
changed	greatly	over	the	past	three	millennia.	Unlike	letters	in	alphabets	that	directly	reflect	the	sounds	of	speech,	Chinese	characters	generally	represent	morphemes—the	units	of	meaning	in	a	language—often	encoding	aspects	of	pronunciation	as	well	as	meaning.	Writing	all	of	a	language's	frequently	used	vocabulary	requires	2000–3000
characters;	as	of	2024,	nearly	100,000	have	been	identified	and	included	in	The	Unicode	Standard.	Characters	are	composed	of	strokes	written	in	a	fixed	order.	Historically,	methods	of	writing	them	include	inscribing	stone,	bone,	or	bronze;	brushing	ink	onto	silk,	bamboo,	or	paper;	and	printing	with	woodblocks	or	moveable	type.	More	recent
technologies	using	Chinese	characters	include	telegraph	codes	and	typewriters,	as	well	as	input	methods	and	text	encodings	on	computers.	(Full	article...)	Recently	featured:	Ezra	Pound	Dracunculiasis	Red-capped	parrot	Archive	By	email	More	featured	articles	About	Marcy	Rheintgen	...	that	Marcy	Rheintgen	(pictured),	a	transgender	woman,	was
jailed	in	a	men's	prison	for	using	a	women's	bathroom	in	Florida?	...	that	a	700-year-old	fortification	in	present-day	South	Korea	was	mostly	destroyed	during	the	construction	of	a	coastal	road?	...	that	some	people	ski	every	month	of	the	year?	...	that	Tarmidi	Suhardjo	was	fired	from	his	party's	leadership	roles	because	he	ran	for	governor?	...	that	Pope
Leo	XIV	was	the	editor-in-chief	of	his	high	school's	yearbook?	...	that	after	Slovak	actress	Hana	Meličková	moved	to	Prague	to	study	piano,	she	secretly	enrolled	in	acting	classes?	...	that	the	riverine	rabbit	was	thought	to	be	extinct	for	more	than	30	years?	...	that	Australian	NFL	player	Laki	Tasi	got	into	American	football	at	the	suggestion	of	a	burger
shop	owner?	...	that	guests	at	the	launch	of	the	bonkbuster	Mount!	were	given	polo	mints	to	feed	to	a	white	stallion?	Archive	Start	a	new	article	Nominate	an	article	Nicușor	Dan	Author	Banu	Mushtaq	and	translator	Deepa	Bhasthi	win	the	International	Booker	Prize	for	Heart	Lamp:	Selected	Stories.	Nicușor	Dan	(pictured)	is	elected	as	president	of
Romania.	In	the	Portuguese	legislative	election,	the	Democratic	Alliance	wins	the	most	seats	in	parliament.	Austria,	represented	by	JJ	with	the	song	"Wasted	Love",	wins	the	Eurovision	Song	Contest.	In	the	Philippines,	the	Alyansa	para	sa	Bagong	Pilipinas	wins	the	most	seats	in	the	Senate	election,	while	Lakas–CMD,	one	of	its	component	parties,	wins
the	most	seats	in	the	House	elections.	Ongoing:	Gaza	war	M23	campaign	Russian	invasion	of	Ukraine	timeline	Sudanese	civil	war	timeline	Recent	deaths:	Benjamin	Ritchie	Jadwiga	Rappé	Bachtiar	Basri	Daniel	Bilalian	Eddie	Sheldrake	Domingos	Maubere	Nominate	an	article	May	24:	Aldersgate	Day	(Methodism)	Eric	XIV	of	Sweden	1567	–	The
mentally	ill	King	Erik	XIV	of	Sweden	(pictured)	and	his	guards	murdered	five	incarcerated	nobles,	including	some	members	of	the	influential	Sture	family.	1689	–	The	Act	of	Toleration	became	law,	granting	freedom	of	worship	to	English	nonconformists	under	certain	circumstances,	but	deliberately	excluding	Catholics.	1798	–	The	Irish	Rebellion	of
1798	began,	with	battles	beginning	in	County	Kildare	and	fighting	later	spreading	across	the	country.	1963	–	United	States	Attorney	General	Robert	F.	Kennedy	met	with	African	American	author	James	Baldwin	in	an	unsuccessful	attempt	to	improve	race	relations.	2014	–	A	gunman	involved	in	Islamic	extremism	opened	fire	at	the	Jewish	Museum	of
Belgium	in	Brussels,	killing	four	people.	Robert	Hues	(d.	1632)Philip	Pearlstein	(b.	1924)Magnus	Manske	(b.	1974)Stormé	DeLarverie	(d.	2014)	More	anniversaries:	May	23	May	24	May	25	Archive	By	email	List	of	days	of	the	year	About	Germanicus	Julius	Caesar	(24	May	15	BC	–	10	October	AD	19)	was	an	ancient	Roman	general	and	politician	most
famously	known	for	his	campaigns	against	Arminius	in	Germania.	The	son	of	Nero	Claudius	Drusus	and	Antonia	Minor,	Germanicus	was	born	into	an	influential	branch	of	the	patrician	gens	Claudia.	The	agnomen	Germanicus	was	added	to	his	full	name	in	9	BC	when	it	was	posthumously	awarded	to	his	father	in	honor	of	his	victories	in	Germania.	In	AD
4	he	was	adopted	by	his	paternal	uncle	Tiberius,	himself	the	stepson	and	heir	of	Germanicus'	great-uncle	Augustus;	ten	years	later,	Tiberius	succeeded	Augustus	as	Roman	emperor.	As	a	result	of	his	adoption,	Germanicus	became	an	official	member	of	the	gens	Julia,	another	prominent	family,	to	which	he	was	related	on	his	mother's	side.	His
connection	to	the	Julii	Caesares	was	further	consolidated	through	a	marriage	between	him	and	Agrippina	the	Elder,	a	granddaughter	of	Augustus.	He	was	also	the	father	of	Caligula,	the	maternal	grandfather	of	Nero,	and	the	older	brother	of	Claudius.	This	bust,	depicting	Germanicus	in	AD	4,	is	in	the	collection	of	the	J.	Paul	Getty	Museum.	Sculpture
credit:	unknown;	photographed	by	J.	Paul	Getty	Museum	Recently	featured:	The	Cocoanuts	In	the	Loge	Black-crowned	barwing	Archive	More	featured	pictures	Community	portal	–	The	central	hub	for	editors,	with	resources,	links,	tasks,	and	announcements.	Village	pump	–	Forum	for	discussions	about	Wikipedia	itself,	including	policies	and	technical
issues.	Site	news	–	Sources	of	news	about	Wikipedia	and	the	broader	Wikimedia	movement.	Teahouse	–	Ask	basic	questions	about	using	or	editing	Wikipedia.	Help	desk	–	Ask	questions	about	using	or	editing	Wikipedia.	Reference	desk	–	Ask	research	questions	about	encyclopedic	topics.	Content	portals	–	A	unique	way	to	navigate	the	encyclopedia.
Wikipedia	is	written	by	volunteer	editors	and	hosted	by	the	Wikimedia	Foundation,	a	non-profit	organization	that	also	hosts	a	range	of	other	volunteer	projects:	CommonsFree	media	repository	MediaWikiWiki	software	development	Meta-WikiWikimedia	project	coordination	WikibooksFree	textbooks	and	manuals	WikidataFree	knowledge	base
WikinewsFree-content	news	WikiquoteCollection	of	quotations	WikisourceFree-content	library	WikispeciesDirectory	of	species	WikiversityFree	learning	tools	WikivoyageFree	travel	guide	WiktionaryDictionary	and	thesaurus	This	Wikipedia	is	written	in	English.	Many	other	Wikipedias	are	available;	some	of	the	largest	are	listed	below.	1,000,000+
articles	 ةيبرعلا 	Deutsch	Español	 یسراف ​	Français	Italiano	Nederlands	日本語	Polski	Português	Русский	Svenska	Українська	Tiếng	Việt	中文	250,000+	articles	Bahasa	Indonesia	Bahasa	Melayu	Bân-lâm-gú	Български	Català	Čeština	Dansk	Eesti	Esperanto	Euskara	עברית	Հայերեն		Magyar	Norsk	bokmål	Română	Simple	English	Slovenčina	Srpski
Srpskohrvatski	Suomi	Türkçe	Oʻzbekcha	50,000+	articles	Asturianu	Azərbaycanca	฀฀฀฀฀	Bosanski	 یدروک 	Ελληνικά	Frysk	Gaeilge	Galego	Hrvatski	ქართული	Kurdî	Latviešu	Lietuvių	฀฀฀฀฀฀	Македонски	฀฀฀฀฀฀฀฀฀฀	Norsk	nynorsk	฀฀฀฀฀฀	Shqip	Slovenščina	฀฀฀	฀฀฀฀฀฀	 ودرا 	Retrieved	from	"	2	Calendar	year	Years	Millennium	2nd	millennium	Centuries
15th	century	16th	century	17th	century	Decades	1540s	1550s	1560s	1570s	1580s	Years	1564	1565	1566	1567	1568	1569	1570	vte	November	10:	Battle	of	Saint-Denis.	1567	by	topic	Arts	and	science	Architecture	Art	Literature	Music	Science	Leaders	Political	entities	State	leaders	Colonial	governors	Religious	leaders	Birth	and	death	categories	Births
–	Deaths	Establishments	and	disestablishments	categories	Establishments	–	Disestablishments	Works	category	Works	vte	1567	in	various	calendarsGregorian	calendar1567MDLXVIIAb	urbe	condita2320Armenian	calendar1016ԹՎ	ՌԺԶAssyrian	calendar6317Balinese	saka	calendar1488–1489Bengali	calendar973–974Berber	calendar2517English
Regnal	year9	Eliz.	1	–	10	Eliz.	1Buddhist	calendar2111Burmese	calendar929Byzantine	calendar7075–7076Chinese	calendar丙寅年	(Fire	Tiger)4264	or	4057				—	to	—丁卯年	(Fire	Rabbit)4265	or	4058Coptic	calendar1283–1284Discordian	calendar2733Ethiopian	calendar1559–1560Hebrew	calendar5327–5328Hindu	calendars	-	Vikram	Samvat1623–
1624	-	Shaka	Samvat1488–1489	-	Kali	Yuga4667–4668Holocene	calendar11567Igbo	calendar567–568Iranian	calendar945–946Islamic	calendar974–975Japanese	calendarEiroku	10(永禄１０年)Javanese	calendar1486–1487Julian	calendar1567MDLXVIIKorean	calendar3900Minguo	calendar345	before	ROC民前345年Nanakshahi	calendar99Thai	solar
calendar2109–2110Tibetan	calendar阳火虎年(male	Fire-Tiger)1693	or	1312	or	540				—	to	—阴火兔年(female	Fire-Rabbit)1694	or	1313	or	541	Year	1567	(MDLXVII)	was	a	common	year	starting	on	Wednesday	of	the	Julian	calendar.	January	20	–	Battle	of	Rio	de	Janeiro:	Portuguese	forces	under	the	command	of	Estácio	de	Sá	definitively	drive	the	French
out	of	Rio	de	Janeiro.	January	23	–	After	45	years'	reign,	the	Jiajing	Emperor,	Zhu	Houcong,	dies	in	the	Forbidden	City	of	China.	January	–	A	Spanish	force	under	the	command	of	Captain	Juan	Pardo	establishes	Fort	San	Juan,	in	the	Native	American	settlement	of	Joara.	The	fort	is	the	first	European	settlement	in	present-day	North	Carolina.	February	4
–	Prince	Zhu	Zaiji,	son	of	the	Jiajing	Emperor,	becomes	the	ascends	the	throne	of	Ming	Dynasty	China	as	the	Longqing	Emperor.[1]	February	10	–	Henry	Stuart,	Lord	Darnley,	husband	of	Mary,	Queen	of	Scots,	is	murdered	at	the	Provost's	House	in	Kirk	o'	Field,	Edinburgh.[2]	March	13	–	Battle	of	Oosterweel:	A	Spanish	mercenary	army	surprises	and
kills	a	band	of	rebels	near	Antwerp	in	the	Habsburg	Netherlands,	beginning	the	Eighty	Years'	War.	April	9	–	In	India,	the	Battle	of	Thanesar	is	fought	in	what	is	now	the	Indian	state	of	Haryana.	The	Mughal	Emperor	Akbar,	with	300	men,	wins	a	victory	over	more	than	7,000	warriors	of	the	Sanyasi	Hindu	sect.	Akbar's	army	has	two	cannons,	400	rifles
and	75	elephants.	April	10	–	Henrique	I	Nerika	a	Mpudi	becomes	the	new	ruler	of	the	Kingdom	of	Kongo	in	what	is	now	the	western	part	of	the	Democratic	Republic	of	the	Congo	and	the	northern	portion	of	Angola.	Henrique	succeeds	his	nephew,	Bernardo	I	of	Kongo	April	12	–	The	Earl	of	Bothwell	is	acquitted	on	charges	of	murder	in	the	February	10
killing	of	Lord	Darnley,	the	husband	of	Mary	Queen	of	Scots.	Upon	acquittal	he	makes	plans	to	become	Mary's	new	husband.	April	20	–	The	Ainslie	Tavern	Bond	is	signed	by	a	group	of	Scottish	clerics	and	nobles	recommends	Bothwell	as	an	appropriate	husband	for	Queen	Mary	and	approves	his	acquittal	after	trial	for	the	murder	of	her	previous
husband.[3]	April	24	–	Bothwell	takes	Mary	prisoner	at	his	castle	at	Dunbar	after	preventing	her	from	traveling	from	her	palace	to	Edinburgh,	then	rapes	her.	May	15	–	Mary,	Queen	of	Scots,	marries	the	Earl	of	Bothwell,	under	duress.[4]	May	24	–	Sture	Murders:	The	mentally	unstable	King	Erik	XIV	of	Sweden	and	his	guards	murder	five	incarcerated
nobles	at	Uppsala	Castle.	June	15	–	Mary,	Queen	of	Scots,	is	defeated	by	Scottish	nobles	at	the	Battle	of	Carberry	Hill	and	imprisoned	in	Lochleven	Castle.	July	24	–	Mary,	Queen	of	Scots,	is	forced	to	abdicate,	and	replaced	by	her	one-year-old	son	James	VI.	July	25	–	The	city	of	Santiago	de	León	de	Caracas	is	founded	by	Diego	de	Losada.	July	29	–
James	VI	is	crowned	at	Stirling.	August	22	–	The	Duke	of	Alba	is	sent	to	the	Netherlands	with	a	strong	Spanish	force,	to	suppress	unrest	there.	He	replaces	Margaret	of	Parma	as	Governor	of	the	Netherlands.	Prince	William	of	Orange	is	outlawed,	and	Lamoral,	Count	of	Egmont	imprisoned.	September	9	–	At	a	dinner,	the	Duke	of	Alba	arrests	Lamoral,
Count	of	Egmont	and	Philip	de	Montmorency,	Count	of	Horn	for	treason.	September	27	–	After	the	2-week	Siege	of	Inabayama	Castle,	the	Oda	clan	capture	Gifu	Castle	from	the	Saitō	clan	in	Japan.	September	29	–	The	Second	War	of	Religion	begins	in	France,	when	Louis,	Prince	of	Condé	and	Gaspard	de	Coligny	fail	in	an	attempt	to	capture	King
Charles	IX	and	his	mother	at	Meaux.	The	Huguenots	do	capture	several	cities	(including	Orléans),	and	march	on	Paris.	October	7	–	Bible	translations	into	Welsh:	The	New	Testament	is	first	published	in	Welsh,	in	William	Salesbury's	translation	from	the	Greek.	November	10	–	Battle	of	Saint-Denis:	Anne	de	Montmorency,	with	16,000	Royalists,	falls	on
Condé's	3,500	Huguenots.	The	Huguenots	surprisingly	hold	on	for	some	hours	before	being	driven	off.	Montmorency	is	mortally	wounded.[5]	November	21	(10th	day	of	11th	month,	Eiroku	10)	–	In	Japan,	the	Tōdai-ji	Great	Buddha	Hall	in	the	Nara	Prefecture	is	destroyed	after	a	six-month	siege	by	Matsunaga	Hisahide	against	Miyoshi	Nagaitsu	and	the
Miyoshi	clan.	Reconstruction	of	the	temple	does	not	take	place	until	140	years	later	in	1709.	December	4	–	Antão	de	Noronha,	Viceroy	of	Portuguese	India	(now	the	Indian	state	of	Goa)	issues	decrees	prohibiting	the	public	performance	of	Hindu	rituals	for	marriages,	cremations,	and	sacred	thread	wearing.	Other	rules	require	all	natives	15	or	older	to
attend	Christian	religious	services,	upon	penalty	of	punishment.[6]	December	12	–	The	Scottish	Parliament	votes	to	approve	the	Act	Anent	the	demission	of	the	Crown	in	favour	of	our	Sovereign	Lord,	and	his	Majesty's	Coronation	1567,	an	act	regarding	the	abdication	of	Mary	Queen	of	Scots	in	favor	of	her	son	James	VI	and	the	coronation	of	James,
and	confirms	James	as	the	legal	ruler.[7]	Mary's	half	brother,	James	Stewart,	1st	Earl	of	Moray,	is	appointed	as	the	regent	to	rule	on	behalf	of	the	18-month-old	King	of	Scotland.	In	that	Moray	is	absent	from	Scotland	at	the	time,	the	Parliament	appoints	a	committee	of	seven	deputy	regents	to	rule	on	behalf	of	Moray's	power	to	rule	on	behalf	of	King
James.	King	Frederick	II	of	Denmark	and	Norway	founds	Fredrikstad	in	Norway.	Construction	of	Villa	Capra	"La	Rotonda"	in	Vicenza,	designed	by	Andrea	Palladio,	begins.	It	will	be	one	of	the	most	influential	designs	in	the	history	of	architecture.[8]	Rugby	School,	one	of	the	oldest	public	schools	in	England,	is	founded.	Although	sparse	maritime	trade
existed	since	its	founding,	the	Ming	dynasty	government	of	China	officially	revokes	the	haijin	maritime	trade	ban,	reinstating	foreign	trade	with	all	countries	except	Japan.[9]	Jacob	van	Heemskerk	Infanta	Catherine	Michelle	of	Spain	January	1	–	Fabio	Colonna,	Italian	scientist	(d.	1640)	January	4	–	François	d'Aguilon,	Belgian	Jesuit	mathematician	(d.
1617)	January	25	–	Archduchess	Margaret	of	Austria	(d.	1633)	January	27	–	Anna	Maria	of	Hesse-Kassel,	Countess	Consort	of	Nassau-Saarbrücke	(d.	1626)	February	3	–	Anna	Maria	of	Brandenburg,	Duchess	Consort	of	Pomerania	(d.	1618)	February	12	–	Thomas	Campion,	English	poet	and	composer	(d.	1620)[10]	February	23	–	Elisabeth	of	Brunswick-
Wolfenbüttel,	Countess	of	Holstein-Schauenburg	and	Duchess	Consort	of	Brunswick-Harburg	(d.	1618)	February	24	–	Jindřich	Matyáš	Thurn,	Swedish	general	(d.	1640)	March	13	(bapt.)	–	Jacob	van	Heemskerk,	Dutch	admiral	and	explorer	(d.	1607)	March	17	–	Akizuki	Tanenaga,	Japanese	samurai	and	soldier	(d.	1614)	April	10	–	John	Louis	I,	Count	of
Nassau-Wiesbaden-Idstein,	Germany	noble	(d.	1596)	April	26	–	Nicolas	Formé,	French	composer	(d.	1638)	May	2	–	Sebald	de	Weert,	Dutch	captain,	vice-admiral	of	the	Dutch	East	India	Company	(d.	1603)	May	9	–	John	George	I,	Prince	of	Anhalt-Dessau	(1603–1618)	(d.	1618)	May	13	–	Don	Giovanni	de'	Medici,	Italian	military	commander	and	diplomat
(d.	1621)	May	15	–	Claudio	Monteverdi,	Italian	composer	(d.	1643)	June	25	–	Jacob	Ulfeldt,	Danish	politician	(d.	1630)	August	14	–	Luigi	Caponaro,	Italian	healer	(d.	1622)	August	15	–	Philip	III,	Margrave	of	Baden-Rodemachern	(1588–1620)	(d.	1620)	August	21	–	Francis	de	Sales,	Savoyard	Bishop	of	Geneva	and	saint	(d.	1622)	September	–	Edward
Sutton,	5th	Baron	Dudley,	English	landowner	(d.	1643)	September	2	–	György	Thurzó,	Palatine	of	Hungary	(d.	1616)	September	5	–	Date	Masamune,	Japanese	daimyō	(d.	1636)	September	24	–	Martin	Fréminet,	French	painter	(d.	1619)	October	10	–	Infanta	Catherine	Michelle	of	Spain	(d.	1597)	November	Thomas	Nashe,	English	poet	(d.	1600)[11]
Minye	Kyawswa	II	of	Ava,	last	crown	prince	of	the	Toungoo	Empire	(Burma)	(d.	1599)	November	1	–	Diego	Sarmiento	de	Acuña,	1st	Count	of	Gondomar,	Spanish	diplomat	(d.	1626)	November	7	–	Margherita	Farnese,	Benedictine	nun	(d.	1643)	November	14	–	Maurice	of	Nassau,	Prince	of	Orange	(d.	1625)	November	16	–	Anna	of	Saxony,	German
noblewoman	(d.	1613)	November	21	–	Anne	de	Xainctonge,	French	religious	(d.	1621)	December	15	–	Christoph	Demantius,	German	composer	(d.	1643)	December	18	Cornelius	a	Lapide,	Jesuit	exegete	(d.	1637)	Tachibana	Muneshige,	Japanese	samurai	and	soldier	(d.	1643)	date	unknown	Isabel	Barreto,	Spanish	admiral	(d.	1612)	Pierre	Biard,	French
settler	and	Jesuit	missionary	(d.	1622)	Adriaen	Block,	Dutch	fur	trader	and	navigator	(d.	1624)	Jacques	Clément,	French	assassin	of	Henry	III	of	France	(d.	1589)	Arima	Harunobu,	Japanese	Christian	daimyō	(d.	1612)	John	Parkinson,	English	herbalist	and	botanist	(d.	1650)	Willem	Schouten,	Dutch	navigator	(d.	1625)	Torii	Tadamasa,	Japanese
nobleman	(d.	1628)	Sanada	Yukimura,	Japanese	samurai	and	soldier	(d.	1615)	Ban	Naoyuki,	Japanese	samurai	and	soldier	(d.	1615)	Emperor	Jiajing	January	12	–	Eva	von	Trott,	German	noble	and	courtier	(b.	1505)	January	17	–	Sampiero	Corso,	Corsican	mercenary	leader	(b.	1498)	January	23	–	Jiajing	Emperor	of	China	(b.	1507)	January	26	–	Nicholas
Wotton,	English	diplomat	(c.	b.	1497)	February	10	–	Henry	Stuart,	Lord	Darnley,	consort	of	Mary,	Queen	of	Scots	(b.	1545)	February	20	–	Estácio	de	Sá,	Portuguese	officer,	founder	of	Rio	de	Janeiro	(b.	1520)	March	31	–	Philip	I,	Landgrave	of	Hesse	(b.	1504)	April	1	–	Jan	Krzysztof	Tarnowski,	Polish	nobleman	(b.	1537)	April	2	–	Ernest	III,	Duke	of
Brunswick-Grubenhagen	(b.	1518)	April	18	–	Wilhelm	von	Grumbach,	German	adventurer	(b.	1503)	April	19	–	Michael	Stifel,	German	mathematician	(b.	1487)	May	2	–	Marin	Držić,	Croatian	writer	(b.	1508)[12]	June	2	–	Shane	O'Neill,	Irish	chieftain	(b.	1530)	June	12	–	Richard	Rich,	Lord	Chancellor	of	England	(b.	1490)	June	19	–	Anna	of	Brandenburg,
Duchess	of	Mecklenburg-Güstrow	(b.	1507)	August	3	–	Myeongjong	of	Joseon,	ruler	of	Korea	(b.	1534)	August	18	–	Enea	Vico,	Italian	engraver	(b.	1523)	October	1	–	Pietro	Carnesecchi,	Italian	humanist	(b.	1508)	October	31	–	Marie	of	Brandenburg-Kulmbach,	Princess	of	Brandenburg-Kulmbach	and	by	marriage	Electress	Palatine	(b.	1519)	November
12	–	Anne	de	Montmorency,	Constable	of	France	(b.	1493)	November	13	–	Pedro	de	la	Gasca,	viceroy	of	Peru	(b.	1485)	November	19	–	Takeda	Yoshinobu,	Japanese	daimyō	(b.	1538)	date	unknown	Thomas	Beccon,	English	Protestant	reformer	(b.	1511)	Péter	Erdődy,	ban	of	Croatia	(b.	1504)	Shahghali,	khan	of	Qasim	(b.	1505)	Lawrence	Sheriff,	English
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State	leaders	14th	century	15th	century	16th	century	Decades	1400s	1410s	1420s	1430s	1440s	1450s	1460s	1470s	1480s	1490s	Categories:	Births	–	Deaths	Establishments	–	Disestablishments	vte	Ottoman	Sultan	Mehmed	II,	victorious	at	the	Ottoman	conquest	of	Constantinople	and	the	fall	of	the	Byzantine	Empire.	Various	historians	describe	it	as
the	end	of	the	Middle	Ages.	The	Surrender	of	Granada	by	Francisco	Pradilla	Ortiz,	1882:	Muhammad	XII	surrenders	to	Ferdinand	and	Isabella	Gergio	Deluci,	Christopher	Columbus	arrives	in	the	Americas	in	1492,	1893	painting.	The	15th	century	was	the	century	which	spans	the	Julian	calendar	dates	from	1	January	1401	(represented	by	the	Roman
numerals	MCDI)	to	31	December	1500	(MD).	In	Europe,	the	15th	century	includes	parts	of	the	Late	Middle	Ages,	the	Early	Renaissance,	and	the	early	modern	period.	Many	technological,	social	and	cultural	developments	of	the	15th	century	can	in	retrospect	be	seen	as	heralding	the	"European	miracle"	of	the	following	centuries.	The	architectural
perspective,	and	the	modern	fields	which	are	known	today	as	banking	and	accounting	were	founded	in	Italy.	The	Hundred	Years'	War	ended	with	a	decisive	French	victory	over	the	English	in	the	Battle	of	Castillon.	Financial	troubles	in	England	following	the	conflict	resulted	in	the	Wars	of	the	Roses,	a	series	of	dynastic	wars	for	the	throne	of	England.
The	conflicts	ended	with	the	defeat	of	Richard	III	by	Henry	VII	at	the	Battle	of	Bosworth	Field,	establishing	the	Tudor	dynasty	in	the	later	part	of	the	century.	Constantinople,	known	as	the	capital	of	the	world	and	the	capital	of	the	Byzantine	Empire,	fell	to	the	emerging	Muslim	Ottoman	Turks,	marking	the	end	of	the	tremendously	influential	Byzantine
Empire	and,	for	some	historians,	the	end	of	the	Middle	Ages.[1]	This	led	to	the	migration	of	Greek	scholars	and	texts	to	Italy,	while	Johannes	Gutenberg's	invention	of	a	mechanical	movable	type	began	the	printing	press.	These	two	events	played	key	roles	in	the	development	of	the	Renaissance.[2][3]	The	Roman	papacy	was	split	in	two	parts	in	Europe
for	decades	(the	so-called	Western	Schism),	until	the	Council	of	Constance.	The	division	of	the	Catholic	Church	and	the	unrest	associated	with	the	Hussite	movement	would	become	factors	in	the	rise	of	the	Protestant	Reformation	in	the	following	century.	Islamic	Spain	became	dissolved	through	the	Christian	Reconquista,	followed	by	the	forced
conversions	and	the	Muslim	rebellion,[4]	ending	over	seven	centuries	of	Islamic	rule	and	returning	southern	Spain	to	Christian	rulers.	The	spices,	wines	and	precious	metals	of	the	Bengal	Sultanate[5]	had	attracted	European	traders	to	trade	with	Bengal,	but	the	trade	was	subsequently	lower,	due	to	the	rise	of	the	Ottoman	Empire,	which	introduced
new	taxes	and	tariffs	against	European	traders.	This	had	led	to	explorers	like	Christopher	Columbus	finding	a	route	to	reach	India,	which	eventually	reached	the	Americas.	Explorers	like	Vasco	da	Gama,	a	Portuguese	traveller,	also	found	a	route	to	reach	to	India	from	the	African	coast.	In	Asia,	the	Timurid	Empire	collapsed	and	the	Afghan	Pashtun
Lodi	dynasty	took	control	of	the	Delhi	Sultanate.	Under	the	rule	of	the	Yongle	Emperor,	who	built	the	Forbidden	City	and	commanded	Zheng	He	to	explore	the	world	overseas,	the	Ming	dynasty's	territory	reached	its	pinnacle.	In	Africa,	the	spread	of	Islam	led	to	the	destruction	of	the	Christian	kingdoms	of	Nubia,	by	the	end	of	the	century,	leaving	only
Alodia	(which	was	to	collapse	in	1504).	The	formerly	vast	Mali	Empire	teetered	on	the	brink	of	collapse,	under	pressure	from	the	rising	Songhai	Empire.	In	the	Americas,	both	the	Aztec	Empire	and	the	Inca	Empire	reached	the	peak	of	their	influence,	but	the	voyages	of	Christopher	Columbus	and	other	European	voyages	of	discovery	in	the	Americas,
beginning	the	European	colonization	of	the	Americas,	changed	the	course	of	modern	history.	Portrait	of	the	founder	of	accounting,	Luca	Pacioli,	by	Jacopo	de'	Barbari	(Museo	di	Capodimonte).	1401:	Dilawar	Khan	establishes	the	Malwa	Sultanate	in	present-day	central	India.	1402:	Ottoman	and	Timurid	Empires	fight	at	the	Battle	of	Ankara	resulting	in
the	capture	of	Bayezid	I	by	Timur.	1402:	Sultanate	of	Malacca	founded	by	Parameswara.[6]	1402:	The	settlement	of	the	Canary	Islands	signals	the	beginning	of	the	Spanish	Empire.	1403–1413:	Ottoman	Interregnum,	a	civil	war	between	the	four	sons	of	Bayezid	I.	1403:	The	Yongle	Emperor	moves	the	capital	of	China	from	Nanjing	to	Beijing.[7]	1404–
1406:	Regreg	War,	Majapahit	civil	war	of	secession	between	Wikramawardhana	against	Wirabhumi.	1405:	The	Sultanate	of	Sulu	is	established	by	Sharif	ul-Hāshim.	1405–1433:	During	the	Ming	treasure	voyages,	Admiral	Zheng	He	of	China	sails	through	the	Indian	Ocean	to	Malacca,	India,	Ceylon,	Persia,	Arabia,	and	East	Africa	to	spread	China's
influence	and	sovereignty.	The	first	voyage,	a	massive	Ming	dynasty	naval	expedition	ending	in	1407,	visited	Java,	Palembang,	Malacca,	Aru,	Samudera	and	Lambri.[8]	1408:	The	last	recorded	event	to	occur	in	the	Norse	settlements	of	Greenland	was	a	wedding	in	Hvalsey	in	the	Eastern	Settlement	in	1408.	The	Northern	Yuan	dynasty	and	Turco-
Mongol	residual	states	and	domains	by	the	15th	century	1410:	The	Battle	of	Grunwald	is	the	decisive	battle	of	the	Polish–Lithuanian–Teutonic	War	leading	to	the	downfall	of	the	Teutonic	Knights.	1410-1415:	The	last	Welsh	war	of	independence,	led	by	Owain	Glyndŵr.	1414:	Khizr	Khan,	deputised	by	Timur	to	be	the	governor	of	Multan,	takes	over
Delhi	founding	the	Sayyid	dynasty.	1415:	Henry	the	Navigator	leads	the	conquest	of	Ceuta	from	the	Moors	marking	the	beginning	of	the	Portuguese	Empire.	1415:	Battle	of	Agincourt	fought	between	the	Kingdom	of	England	and	France.	1415:	Jan	Hus	is	burned	at	the	stake	as	a	heretic	at	the	Council	of	Constance.	1417:	A	large	goodwill	mission	led
by	three	kings	of	Sulu,	the	Eastern	King	Paduka	Pahala,	the	Western	king	Maharaja	Kolamating	and	Cave	king	Paduka	Prabhu	as	well	as	340	members	of	their	delegation,	in	what	is	now	the	southern	Philippines,	ploughed	through	the	Pacific	Ocean	to	China	to	pay	tribute	to	the	Yongle	emperor	of	the	Ming	Dynasty.[9]	1417:	The	East	king	of	Sulu,
Paduka	Pahala,	on	their	way	home,	suddenly	died	in	Dezhou,	a	city	in	east	China's	Shandong	province.	The	Yongle	Emperor	Zhu	Di	commissioned	artisans	to	build	a	tomb	for	the	king.[10]	1419–1433:	The	Hussite	Wars	in	Bohemia.	Joan	of	Arc,	a	French	peasant	girl,	directly	influenced	the	result	of	the	Hundred	Years'	War.	1420:	Construction	of	the
Chinese	Forbidden	City	is	completed	in	Beijing.	1420:	In	Sub-saharan	Africa	the	Ife	Empire	has	collapsed.	1424:	James	I	returns	to	Scotland	after	being	held	hostage	under	three	Kings	of	England	since	1406.	1424:	Deva	Raya	II	succeeds	his	father	Veera	Vijaya	Bukka	Raya	as	monarch	of	the	Vijayanagara	Empire.	1425:	Catholic	University	of	Leuven
(Belgium)	founded	by	Pope	Martin	V.	1427:	Reign	of	Itzcoatl	begins	as	the	fourth	tlatoani	of	Tenochtitlan	and	the	first	emperor	of	the	Aztec	Empire.	1429:	Joan	of	Arc	ends	the	Siege	of	Orléans	and	turns	the	tide	of	the	Hundred	Years'	War.	1429:	Queen	Suhita	succeeds	her	father	Wikramawardhana	as	ruler	of	Majapahit.[11]	1430:	Rajah	Lontok	and
Dayang	Kalangitan	become	co-regent	rulers	of	the	ancient	kingdom	of	Tondo.	1431	9	January	–	Pretrial	investigations	for	Joan	of	Arc	begin	in	Rouen,	France	under	English	occupation.	3	March	–	Pope	Eugene	IV	succeeds	Pope	Martin	V,	to	become	the	207th	pope.	26	March	–	The	trial	of	Joan	of	Arc	begins.	30	May	–	Nineteen-year-old	Joan	of	Arc	is
burned	at	the	stake.	16	June	–	the	Teutonic	Knights	and	Švitrigaila	sign	the	Treaty	of	Christmemel,	creating	anti-Polish	alliance	September	–	Battle	of	Inverlochy:	Donald	Balloch	defeats	the	Royalists.	30	October	–	Treaty	of	Medina	del	Campo,	consolidating	peace	between	Portugal	and	Castille.	16	December	–	Henry	VI	of	England	is	crowned	King	of
France.	1434:	The	Catholics	and	Utraquists	defeat	the	Taborites	at	the	Battle	of	Lipany,	ending	the	Hussite	Wars.	1438:	Pachacuti	founds	the	Inca	Empire.	Detail	of	The	Emperor's	Approach	showing	the	Xuande	Emperor's	royal	carriage.	Ming	dynasty	of	China.	1440:	Eton	College	founded	by	Henry	VI.	1440s:	The	Golden	Horde	breaks	up	into	the
Siberia	Khanate,	the	Khanate	of	Kazan,	the	Astrakhan	Khanate,	the	Crimean	Khanate,	and	the	Great	Horde.	1440–1469:	Under	Moctezuma	I,	the	Aztecs	become	the	dominant	power	in	Mesoamerica.	1440:	Oba	Ewuare	comes	to	power	in	the	West	African	city	of	Benin,	and	turns	it	into	an	empire.	1440:	Reign	of	Moctezuma	I	begins	as	the	fifth	tlatoani
of	Tenochtitlan	and	emperor	of	the	Aztec	Empire.	1441:	Jan	van	Eyck,	Flemish	painter,	dies.	1441:	Portuguese	navigators	cruise	West	Africa	and	reestablish	the	European	slave	trade	with	a	shipment	of	African	slaves	sent	directly	from	Africa	to	Portugal.	1441:	A	civil	war	between	the	Tutul	Xiues	and	Cocom	breaks	out	in	the	League	of	Mayapan.	As	a
consequence,	the	league	begins	to	disintegrate.	1442:	Leonardo	Bruni	defines	Middle	Ages	and	Modern	times.	1443:	Abdur	Razzaq	visits	India.	1443:	King	Sejong	the	Great	publishes	the	hangul,	the	native	phonetic	alphabet	system	for	the	Korean	language.	1444:	The	Albanian	league	is	established	in	Lezha,	Skanderbeg	is	elected	leader.	A	war	begins
against	the	Ottoman	Empire.	An	Albanian	state	is	set	up	and	lasts	until	1479.	1444:	Ottoman	Empire	under	Sultan	Murad	II	defeats	the	Polish	and	Hungarian	armies	under	Władysław	III	of	Poland	and	János	Hunyadi	at	the	Battle	of	Varna.	1445:	The	Kazan	Khanate	defeats	the	Grand	Duchy	of	Moscow	at	the	Battle	of	Suzdal.	1446:	Mallikarjuna	Raya
succeeds	his	father	Deva	Raya	II	as	monarch	of	the	Vijayanagara	Empire.	1447:	Wijaya	Parakrama	Wardhana,	succeeds	Suhita	as	ruler	of	Majapahit.[11]	1449:	Saint	Srimanta	Sankardeva	was	born.	1449:	Esen	Tayisi	leads	an	Oirat	Mongol	invasion	of	China	which	culminate	in	the	capture	of	the	Zhengtong	Emperor	at	Battle	of	Tumu	Fortress.	Angkor,
the	capital	of	the	Khmer	Empire,	was	abandoned	in	the	15th	century.	1450s:	Machu	Picchu	constructed.	1450:	Dayang	Kalangitan	became	the	Queen	regnant	of	the	ancient	kingdom	of	Tondo	that	started	Tondo's	political	dominance	over	Luzon.	1451:	Bahlul	Khan	Lodhi	ascends	the	throne	of	the	Delhi	sultanate	starting	the	Lodhi	dynasty	1451:
Rajasawardhana,	born	Bhre	Pamotan,	styled	Brawijaya	II	succeeds	Wijayaparakramawardhana	as	ruler	of	Majapahit.[11]	1453:	The	Fall	of	Constantinople	marks	the	end	of	the	Byzantine	Empire	and	the	death	of	the	last	Roman	Emperor	Constantine	XI	and	the	beginning	of	the	Classical	Age	of	the	Ottoman	Empire.	1453:	The	Battle	of	Castillon	is	the
last	engagement	of	the	Hundred	Years'	War	and	the	first	battle	in	European	history	where	cannons	were	a	major	factor	in	deciding	the	battle.	1453:	Reign	of	Rajasawardhana	ends.[11]	1454–1466:	After	defeating	the	Teutonic	Knights	in	the	Thirteen	Years'	War,	Poland	annexes	Royal	Prussia.	1455–1485:	Wars	of	the	Roses	–	English	civil	war	between
the	House	of	York	and	the	House	of	Lancaster.	1456:	Joan	of	Arc	is	posthumously	acquitted	of	heresy	by	the	Catholic	Church,	redeeming	her	status	as	the	heroine	of	France.	1456:	The	Siege	of	Belgrade	halts	the	Ottomans'	advance	into	Europe.	1456:	Girishawardhana,	styled	Brawijaya	III,	becomes	ruler	of	Majapahit.[11]	1457:	Construction	of	Edo
Castle	begins.	The	seventeen	Kuchkabals	of	Yucatán	after	The	League	of	Mayapan	in	1461.	1461:	The	League	of	Mayapan	disintegrates.	The	league	is	replaced	by	seventeen	Kuchkabal.	1461:	The	city	of	Sarajevo	is	founded	by	the	Ottomans.	1461:	2	February	–	Battle	of	Mortimer's	Cross:	Yorkist	troops	led	by	Edward,	Duke	of	York	defeat	Lancastrians
under	Owen	Tudor	and	his	son	Jasper	Tudor,	Earl	of	Pembroke	in	Wales.	17	February	–	Second	Battle	of	St	Albans,	England:	The	Earl	of	Warwick's	army	is	defeated	by	a	Lancastrian	force	under	Queen	Margaret,	who	recovers	control	of	her	husband.	4	March	–	The	Duke	of	York	seizes	London	and	proclaims	himself	King	Edward	IV	of	England.	5
March	–	Henry	VI	of	England	is	deposed	by	the	Duke	of	York	during	war	of	the	Roses.	29	March	–	Battle	of	Towton:	Edward	IV	defeats	Queen	Margaret	to	make	good	his	claim	to	the	English	throne	(thought	to	be	the	bloodiest	battle	ever	fought	in	England).	28	June	–	Edward,	Richard	of	York's	son,	is	crowned	as	Edward	IV,	King	of	England	(reigns
until	1483).	July	–	Byzantine	general	Graitzas	Palaiologos	honourably	surrenders	Salmeniko	Castle,	last	garrison	of	the	Despotate	of	the	Morea,	to	invading	forces	of	the	Ottoman	Empire	after	a	year-long	siege.Political	map	of	Europe	in	1470	22	July	–	Louis	XI	of	France	succeeds	Charles	VII	of	France	as	king	(reigns	until	1483).	1462:	Sonni	Ali	Ber,
the	ruler	of	the	Songhai	(or	Songhay)	Empire,	along	the	Niger	River,	conquers	Mali	in	the	central	Sudan	by	defeating	the	Tuareg	contingent	at	Tombouctou	(or	Timbuktu)	and	capturing	the	city.	He	develops	both	his	own	capital,	Gao,	and	the	main	centres	of	Mali,	Timbuktu	and	Djenné,	into	major	cities.	Ali	Ber	controls	trade	along	the	Niger	River
with	a	navy	of	war	vessels.	1462:	Mehmed	the	Conqueror	is	driven	back	by	Wallachian	prince	Vlad	III	Dracula	at	The	Night	Attack.	1464:	Edward	IV	of	England	secretly	marries	Elizabeth	Woodville.	1465:	The	1465	Moroccan	revolt	ends	in	the	murder	of	the	last	Marinid	Sultan	of	Morocco	Abd	al-Haqq	II.	1466:	Singhawikramawardhana,	succeeds
Girishawardhana	as	ruler	of	Majapahit.[11]	1467:	Uzun	Hasan	defeats	the	Black	Sheep	Turkoman	leader	Jahān	Shāh.	1467–1615:	The	Sengoku	period	is	one	of	civil	war	in	Japan.	1469:	The	marriage	of	Ferdinand	II	of	Aragon	and	Isabella	I	of	Castile	leads	to	the	unification	of	Spain.The	renaissance	king	Matthias	Corvinus	of	Hungary.	His	mercenary
standing	army	(the	Black	Army)	had	the	strongest	military	potential	of	its	era.	1469:	Matthias	Corvinus	of	Hungary	conquers	some	parts	of	Bohemia.	1469:	Birth	of	Guru	Nanak	Dev.	Beside	followers	of	Sikhism,	Guru	Nanak	is	revered	by	Hindus	and	Muslim	Sufis	across	the	Indian	subcontinent.	1469:	Reign	of	Axayacatl	begins	in	the	Aztec	capital	of
Tenochtitlan	as	the	sixth	tlatoani	and	emperor	of	the	Aztec	Triple	Alliance.	1470:	The	Moldavian	forces	under	Stephen	the	Great	defeat	the	Tatars	of	the	Golden	Horde	at	the	Battle	of	Lipnic.	1471:	The	kingdom	of	Champa	suffers	a	massive	defeat	by	the	Vietnamese	king	Lê	Thánh	Tông.	1472:	Abu	Abd	Allah	al-Sheikh	Muhammad	ibn	Yahya	becomes
the	first	Wattasid	Sultan	of	Morocco.	1474–1477:	Burgundy	Wars	of	France,	Switzerland,	Lorraine	and	Sigismund	II	of	Habsburg	against	the	Charles	the	Bold,	Duke	of	Burgundy.	1478:	Muscovy	conquers	Novgorod.	1478:	Reign	of	Singhawikramawardhana	ends.[11]	1478:	The	Great	Mosque	of	Demak	is	the	oldest	mosque	in	Java,	built	by	the	Wali
Songo	during	the	reign	of	Sultan	Raden	Patah.	1479:	Battle	of	Breadfield,	Matthias	Corvinus	of	Hungary	defeated	the	Turks.	1479:	JagatGuru	Vallabhacharya	Ji	Mahaprabhu	was	born[12]	The	Siege	of	Rhodes	(1480).	Ships	of	the	Hospitaliers	in	the	forefront,	and	Turkish	camp	in	the	background.	1480:	After	the	Great	standing	on	the	Ugra	river,
Muscovy	gained	independence	from	the	Great	Horde.	1481:	Spanish	Inquisition	begins	in	practice	with	the	first	auto-da-fé.	1481:	Reign	of	Tizoc	begins	as	the	seventh	tlatoani	of	Tenochtitlan	and	the	emperor	of	the	Aztec	Triple	Alliance.	1482:	Portuguese	navigator	Diogo	Cão	becomes	the	first	European	to	enter	the	Congo.	1483:	The	Jews	are	expelled
from	Andalusia.	1483:	Pluto	moves	inside	Neptune's	orbit	until	July	23,	1503,	according	to	modern	orbital	calculations.	1484:	William	Caxton,	the	first	printer	of	books	in	English,	prints	his	translation	of	Aesop's	Fables	in	London.	1485:	Matthias	Corvinus	of	Hungary	captured	Vienna,	Frederick	III,	Holy	Roman	Emperor	ran	away.	1485:	Henry	VII
defeats	Richard	III	at	the	Battle	of	Bosworth	and	becomes	King	of	England.	1485:	Ivan	III	of	Russia	conquered	Tver.	1485:	Saluva	Narasimha	Deva	Raya	drives	out	Praudha	Raya	ending	the	Sangama	Dynasty.	1486:	Sher	Shah	Suri,	is	born	in	Sasaram,	Bihar.	1486:	Reign	of	Ahuitzotl	begins	as	the	eighth	tlatoani	of	Tenochtitlan	and	emperor	of	the
Aztec	Triple	Alliance.	1487:	Hongzhi	Emperor	ascends	the	throne,	bringing	Confucian	ideology	under	his	administration.	1488:	Portuguese	Navigator	Bartolomeu	Dias	sails	around	the	Cape	of	Good	Hope.	View	of	Florence,	birthplace	of	the	Renaissance,	in	a	1493	woodcut	from	Hartmann	Schedel's	Nuremberg	Chronicle	1492:	The	death	of	Sunni	Ali
Ber	left	a	leadership	void	in	the	Songhai	Empire,	and	his	son	was	soon	dethroned	by	Mamadou	Toure	who	ascended	the	throne	in	1493	under	the	name	Askia	(meaning	"general")	Muhammad.	Askia	Muhammad	made	Songhai	the	largest	empire	in	the	history	of	West	Africa.	The	empire	went	into	decline,	however,	after	1528,	when	the	now-blind	Askia
Muhammad	was	dethroned	by	his	son,	Askia	Musa.	1492:	Boabdil's	surrender	of	Granada	marks	the	end	of	the	Spanish	Reconquista	and	Al-Andalus.	1492:	Ferdinand	and	Isabella	sign	the	Alhambra	Decree,	expelling	all	Jews	from	Spain	unless	they	convert	to	Catholicism;	40,000–200,000	leave.	1492:	Christopher	Columbus	landed	in	the	Americas	from
Spain.	1493:	Christopher	Columbus	landed	on	modern-day	Puerto	Rico.	1493:	Leonardo	da	Vinci	creates	the	first	known	design	for	a	helicopter.	1494:	Spain	and	Portugal	sign	the	Treaty	of	Tordesillas	and	agree	to	divide	the	World	outside	of	Europe	between	themselves.	1494–1559:	The	Italian	Wars	lead	to	the	downfall	of	the	Italian	city-states.	1495:
Manuel	I	succeeds	John	II	as	the	king	of	Portugal	(reigns	until	1521).	1497–1499:	Vasco	da	Gama's	first	voyage	from	Europe	to	India	and	back.	1499:	Ottoman	fleet	defeats	Venetians	at	the	Battle	of	Zonchio.	1499:	University	"Alcalá	de	Henares"	in	Madrid,	Spain	is	built.	1499:	Michelangelo's	Pietà	in	St.	Peter's	Basilica	is	made	in	Rome	1500:	Islam
becomes	the	dominant	religion	across	the	Indonesian	archipelago.[13]	1500:	in	an	effort	to	increase	his	power.	Bolkiah	founded	the	city	of	Selurong—later	named	Maynila,	on	the	other	side	of	the	Pasig	River	shortly	after	taking	over	Tondo	from	its	monarch,	Lakan	Gambang.[14]	1500:	Around	late	15th	century	Bujangga	Manik	manuscript	was
composed,	tell	the	story	of	Jaya	Pakuan	Bujangga	Manik,	a	Sundanese	Hindu	hermit	journeys	throughout	Java	and	Bali.[15]	1500:	Charles	of	Ghent	(future	Lord	of	the	Netherlands,	King	of	Spain,	Archduke	of	Austria,	and	Holy	Roman	Emperor)	was	born.	1500:	Guru	Nanak	begins	the	spreading	of	Sikhism,	the	fifth-largest	religion	in	the	world.	1500:
Spanish	navigator	Vicente	Yáñez	Pinzón	encounters	Brazil	but	is	prevented	from	claiming	it	by	the	Treaty	of	Tordesillas.	1500:	Portuguese	navigator	Pedro	Álvares	Cabral	claims	Brazil	for	Portugal.	1500:	The	Ottoman	fleet	of	Kemal	Reis	defeats	the	Venetians	at	the	Second	Battle	of	Lepanto.	The	Yongle	Emperor	(1360–1424)	raised	the	Ming	Empire
to	its	highest	power.	Launched	campaigns	against	the	Mongols	and	reestablished	Chinese	rule	in	Vietnam	Ulugh	Beg	(1394–1449),	Timurid	sultan	who	oversaw	the	cultural	peak	of	the	Timurid	Renaissance	Johannes	Gutenberg	(1400–1468),	German	inventor	who	introduced	printing	to	Europe	with	his	mechanical	movable-type	printing	press
Skanderbeg	(1405–1468),	who	led	the	Albanian	resistance	against	the	Ottoman	Empire	Ivan	III	of	Russia	(1440–1505),	Grand	Prince	of	Moscow	who	ended	the	dominance	of	the	Tatars	in	the	lands	of	the	Rus	King	Henry	VII	(1457–1509),	the	founder	of	the	royal	house	of	Tudor	See	also:	Science	and	inventions	of	Leonardo	da	VinciSee	also:	Timeline	of
historic	inventions	§	15th	century	Renaissance	affects	philosophy,	science	and	art.	Rise	of	Modern	English	language	from	Middle	English.	Introduction	of	the	noon	bell	in	the	Catholic	world.	Public	banks.	Yongle	Encyclopedia—over	22,000	volumes.	Hangul	alphabet	in	Korea.	Scotch	whisky.	Psychiatric	hospitals[clarification	needed].	Development	of
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